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» I FISCal

Project Objectives

m  The Financial Information System for California (FI$Cal) is a business
transformation project for the State in the areas of budgeting, accounting,
procurement, and cash management. The Project prepares the State to
work in an integrated financial management system.

m The four partner agencies are working together to form the partnerships to
support FI$Cal at the highest level. These partner agencies are:

Department of Finance

State Controller’s Office

State Treasurer’s Office
Department of General Services
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» I FISCal

Project Objectives

To realize FI$Cal's vision of implementing a statewide Enterprise Resource
Planning system, and to best serve the interests of the State's four partner
agencies and 150+ participating entities, 17 objectives have been identified.

These 17 objectives can be divided into three major categories:

Better Better Better

Technology Processes Data

'
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" FIsCal
Better Technology

m  Replace the State's aging legacy financial management systems and
eliminate fragmented and diverse reporting by implementing standardized
financial management processes and systems across all departments
and control agencies.

m Implement a stable and secure information technology infrastructure.

m  Automate manual processes by providing the ability to electronically
receive and submit financial management documents and data between
agencies, departments, banks, vendors, and other government entities.

m Enable the State to more quickly implement, track, and report on
changes to financial management processes and systems to accommodate
new information such as statutory changes and performance information.

m Improve role-based security and workflow authorization by capturing
near real-time data from the State's human resources system of record.
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" FisCal

Better Processes

m  Streamline the accounts receivable collections process and allow for offset
capability which will provide the ability for increased cash collection.

m Increase investment returns through the timely and accurate monitoring of
cash balances, cash flow forecasting, and timing of receipts and
disbursements.

m  Streamline the payment process and allow for faster vendor payments
that will reduce late payment penalty fees paid by the State.

m Reduce procurement cycle time by automating purchasing authority limits
and approval dependencies, and easing access to goods and services
available from existing sources, including, but not limited to, using leveraged
procurement agreements.

m Provide online access to financial management information resulting in a
reduction of payment or approval inquiries, or both.
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» I FISCal

Better Processes

m  Reduce time, workload, and costs associated with capturing and
projecting revenues, expenditures, and program needs for multiple years
and scenarios, and for tracking, reporting, and responding to legislative
actions.

m Track purchase volumes and costs by vendor and commodity code or
service code to increase strategic sourcing opportunities, reduce purchase
prices, and capture total State spending data.

m Increase competition by promoting business opportunities through use of
electronic bidding, online vendor interaction, and automated vendor
functions.
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" S FI$Cal
Better Data

m Improve access and transparency of California's financial management
information, allowing the implementation of increased auditing, compliance
reporting, and fiscal accountability while sharing information between the
public, the Legislature, external stakeholders, state, federal, and local
agencies.

m Improve the State's ability to preserve, access, and analyze historical
financial management information to reduce the workload required to
research and prepare this information.

m Improve fiscal controls and support better decision making by State
managers and the Legislature by enhancing the quality, timeliness,
consistency, and accessibility of financial management information
through the use of powerful data access tools, standardized data, and
financial management reports.

m  Maintain a central source for financial management data to reduce the
time and expense of vendors, departments, and agencies collecting,
maintaining, and reconciling redundant data.
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" S FI$Cal

Functional Capabilities

Hyperion Budgeting Procurement Grants Management Customer Contracts
e Prepare Budgets e Create/Approve Requisitions e Create Proposals ¢ Create Customer Contracts
e Enact Budgets e Create/Award Solicitations e Generate Awards e Activate Customer Contracts
e Administer Budgets e Create/Approve Procurement » Update Award Profiles ¢ Amend Customer Contracts
Contracts e Process Grants ¢ Close Customer Contracts

e Create/Approve Purchase Orders
e Create Receipts
e Process P-Cards

Project Costing Accounts Payable Cash Management
¢ Create Projects * Create Customers » Create Vendors ¢ Manage Bank Accounts
¢ Create Project Budgets e Maintain Customers » Create Vouchers ¢ Reconcile Banks
* Collect, Distribute, & Price Costs * Process Bills » Perform Voucher Matching ¢ Manage Cash
¢ Process Project Capitalization e Generate Invoices * Process Payments e Forecast Cash

* Enter Receivables

* Maintain Receivables
* Collect Receivables

e Apply Payments

Asset Management Labor Distribution General Ledger Commitment Control
e Acquire Assets e Load SCO Payroll Data » Enter Journals « Enter Budget Journals
e Maintain Assets * Reconcile Data » Process Journals « Define Budgets
e Perform Asset Stocktaking e Process Labor Distribution » Process Allocations e Track Budgets
» Depreciate Assets * Resolve Errors » Process Financial Statements * Report Budgets
e Transfer Assets * Maintain Chart of Accounts

* Retire/Reinstate Assets
e Lease Assets
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" FI$Cal

FISCAL BUDGETING SOLUTION

Hyperion Budgeting

October 2015 FI$Cal: Transparency. Accuracy. Integrity 13



" S F.

al

\\\
/
=}
: . General Ledger /
Project Costing Commitment Control
. . COA
Capital Project values
IDs & Names .
Appropriations
l & Adjustments l
I
Budget Processor e ——————
Budget Approver Budget Budget Budget
Preparation Enactment Administration [REPORTS
» Department Issue codes for All

BRs

| «  Expenditure by Entity, Program,
and Category

Budget, May * Appropriation Summary report

SmartView Appropriations & Revision
Adhoc Report Adjustments Enacted Budget * Legislative Action worksheet

l

Reports DOF system

DataMart (GBPS)
system

eBudget website

v

e

October 2015 FI$Cal: Transparency. Accuracy. Integrity.

14



FISCal

Hyperion Budgeting (BU)

Key Solution Characteristics:

Integrated Chart of Accounts

Stand alone Budgeting solution integrated with PeopleSoft
Commitment Control (KK)

Ability to mange the Budget Legislation process

Ability administer the Budget through preparing, analyzing and
approving appropriations and adjustments

Ability to prepare the Governor’s Budget through the use of
Budget Requests

Allows tracking of Capital projects by the Phase level

Ability to Rollover continuous appropriations from one fiscal year
to the other

Ability to archive and report on the previous fiscal year's enacted
budget

Publish the Governor’s Budget onto the eBudget website

Configuration

« None

Conversions

e EXTBUOO1 — Budget Administration
e EXTBUOO2 — Budget Preparation
 EXTBUOO3 — Capital Outlay

e EXTBUOO04 — Forecasting

Training

BU101 - Introduction to Budgeting

BU112 - Review and Update Departmental Budgets
BU113 - Budget Development Using Decision Packages
BU116 - Capital Outlay

BU222 - Upload Templates

Interfaces

* INFBUO10 - Excel Upload for Budget Change Proposal Data

* INFBUO11 - Excel Upload for Capital Change Proposal Data

* INFBUO12 - Excel Upload of Reconciled Authorized Positions

* INFBUO13 - Excel Upload of ECP Change Proposal Data

* INFBUO14 - Excel Upload of Transfers Loans reorganization Data
« INFBUO15 - Excel Upload of Planning Estimate Adjustments Data
* INFBUO16 - Excel Upload of Budget Adjustments Data

» INFBUO17 - Excel Upload Borrowable Fund Data

October 2015
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FISCAL PROCUREMENT
SOLUTION

FISCal

Requisition to Receiving, P-Card
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Requisition to Recelving

Proc
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Dept. P-Card Req and
P-Card User

Dept. P-Card Reconciler
Dept. P-Card Approver

P-Card transactions

Create PO Upload : :
Using P-Cardy Monthly N[0]113% Reconcile Approve

Number

Cardholder Statement Transactions
Statements

Transactions in AP
Staging table

'

Accounts
Payables

o

'REPORTS il

Card Holder information
report

Account Summary
report

Purchase details report
Top Merchant category
report
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Procurement Solution

FisCal

Key Solution Characteristics:

» Various route controls in addition to Business Unit are
available for procurement workflow routing:

» Acquisition type, reporting structure, and transaction dollar
amount for Requisitions and Purchase Orders (POs)

» Acquisition type and transaction dollar amount for
Procurement Contracts

» Acquisition type for posting of Solicitation Events

» Procurement transactions may include ad hoc departmental
approvers as well as external (DGS) approvers

» Integration with Account Payables and other modules

» EPP/SABRC tracking and reporting available for every
transaction

» Online P-Card reconciliation available in FI$Cal

» With FI$Cal, the departments now can capture sub
contracting information

* Minimize paper approval required as FI$Cal handles the
workflow approval electronically in the system

Configuration
+ CB_CPOO02
» Define Location and Ship To Locations
» Define Standard Comment s and Type
» Define Purchasing Definition
» Define Item (PO Item ID)
» Approval Signatures
* CB_CPOO3 - Define inspection and routing procedures

Conversions

e CNVPO104 - Procurement Contracts Conversions
* CNVPO105 - Item Conversions (as applicable)

« CNVPO107 — Open PO Conversions

Training

* PO101 - Introduction Requisitions, POs, and Receiving
» PO112 - Processing Requisitions

* PO122 - Processing Purchase Orders

» PO0O226 - Using P-Cards

* PO0142/152 - Processing Solicitations and Contracts

» PO371 - SB-DVBE Certifications

» PO372 - Managing ltems

Interfaces

» INFPO105 - FI$Cal SCPRS Interface with non-Wave depts
* INFPO106 - FI$Cal CSCR Progress Payment Interface

October 2015
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" FIsCal

FISCAL ACCOUNTING SOLUTION

Grants Management, Customer Contracts, Project
Costing, Billing, Accounts Receivable, Accounts Payable,
Cash Management, Asset Management, Labor
Distribution, General Ledger, Commitment Control
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" A Fngal
Grants Management (GM)

Grant Processor Update
Grant Approver Create Generate Avvard Process

Proposal Award Profile Grants

Project data Grants Budget finalization process

| Contract data for
| | Billing and Revenue

Budget rows Posted Budgets recognition

v v

Project Costing

Commitment

Control

Federal
drawdown LOC

'REPORTS

Revenue, Facilities

Administration » LOC
¢ Federal Financial
l Report (FFR)

* Federal Cash Tracking
+ FFATA

General Ledger
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" FisCal
Grants Management (GM) and Customer
Contracts (CA)

Key Solution Characteristics: Configuration

» Capture contractual terms and conditions of awards and * None
reimbursable projects

» Facilitate Invoice generation by staging billable data in Billing
Module

* Choose when and how to recognize revenue in a suitable
manner

» Manage the complete grant life cycle from proposal to award

» Key to automatic integration for Customer Contract, Project,

and Budget Conversions
« CNVGMOO0L1 - Grants Management
* CNVPCO003 - Customer Contracts
Trainin Interfaces
e GM101 - Introduction to Grant Management * None

« GM112 - Managing Grants
* PC122 - Introduction to Customer Contracts
» PC123 - Customer Contract Management within PC
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Project Costing (PC)

ePro/ Grants &
Purchasing Contracts
Create
Encumbrances Projects

|

Create Create

Projects Project
Budgets

Project Processor

Fund
Distribution

Budgets

General Ledger

Commitment
Control

Accounts

Payables

Billing Status Billing Expenses

s |

Collect, :
Distribute Propct_ :
& Price Capitalization

Costs

Project Capital Assets

information  Expenditures l

Asset
Management

Departmental
Transactional

System

Labor
Distribution

N

IREPORTS il

* Project/ Grants status

report

* Project Financial
Reports

« Billing and Revenue
Report
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Project Costing (PC)

FISCal

Key Solution Characteristics:

» Provides detailed project information

» Captures State federal match

» Cost collection and processing tool

» Acts as a data warehouse and costs are collected from,
Commitment Control

Grants

Purchasing —Encumbrance/ Committed Costs
Accounts Payable — Actual Expenditures and
Commitment reversals

General Ledger — Expenses and/or Revenue Journals
Customer Contracts — Amount Based Billing and
Revenue

» Billing — Billing Adjustments

» Asset Management — Capitalization and Depreciation

VVVY

VY VY

Configuration

« CB_CPCO03
» Set up Source Type
» Set up Category
» Set up Sub-Category

Conversions

* CNVPCO002A - Projects (Project)

« CNVPCO002B - Projects (Activities)
* CNVPCO002C - Projects (Team)

Training

* PC101 - Introduction to Project Costing
« PC112 - Maintaining Projects in FI$Cal
* PC113 - Processing Project Costs

» PC114 - Analyzing Projects

» PC222 - Introduction to Primavera

Interfaces

* INFPCO003 - Project Transaction Interface

INFPCO004 - Project Interface ((Project,team,activities)

INFPCO010 - Outbound Interface from PC for Project Structure
INFPCO011 - Outbound Interface from PC for Project Transactions
INFPCO012 - Inbound interface to Add/Update Rate Sets

October 2015
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Billing (BI)

L ¥
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Departmental Project Costing Cllsiioiiizr
Billing Contracts
Systems
Project Contract
Customer data Invoices Billings Billings

| | | |

Customer Processor
Bl Processor

BI Approver EEEEEEEN Create Maintain Process Generate
Customer Customer Bill Invoice
AR R PR TR O,
Invoice Inter-departmental Revenue &
Details Invoices Receivables

| | |

Accounts Accounts
Receivables Payables

General Ledger

-

> REPORTS il

* Invoice Register
¢ AR Pending Item report
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FI$Cal
Billing (BI) '

Key Solution Characteristics: Configuration

* Invoices are system generated *+ CB_CARO02 - Set up distribution codes

» Separate customer list by department & detailed customer
information available

» Automated recurring invoices

» Auto generate Credit and Rebill invoices

» Automated AP voucher creation for interdepartmental invoices

Conversions
¢ CNVAROO01 — Customers
* CNVARO0O02 - Open Receivables

Training Interfaces
* BI/AR101 - Introduction to Billing and Accounts Receivable * INFARO11 - Customer ID Extract
¢ BI/AR102 - Maintaining Customers » INFAROQOS - Interface for invoice adjustments

* BI113 - Creating and Processing Billing
» BI214 - Advanced Billing Processes
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Accounts Receivable (AR)
X il Emem hecount

AR Payment Approver
Collection Processor

Inter Departmental
payments

v

Invoices

1
Deposit  Deposit Details T
Details & Open AR
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Enter Maintain Collect Apply
Receivables Receivables Receivables Payments

Delinquent
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¢ l l information

Cash

General Ledger

FTB Intercept

Management
Program

A 4

1

Dunning Lette

=

v

S
R
Q‘b

'REPORTS

Cash Receipts report

Customer account History report
Customer statement report
Customer conversation report
Customer refund report
Receivable remittance report
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FisCal

Accounts Receivable (AR)

Key Solution Characteristics:

» Receivables ‘Workbench’ functionality to facilitate collections
» System generated Customer statements

» System generated Dunning letters

» Automated Overdue charges assessment

« Automated payment application (‘Payment Predictor’)

Configuration

*+ CB_CARO02 - Set up distribution codes

Conversions
¢ CNVARO0O01 - Customers
* CNVARO0O02 - Open Receivables

Training

* BI/AR101 - Introduction to Billing and Accounts Receivable
* BI/AR102 - Maintaining Customers

« AR123 - Creating and Maintaining Receivables

« AR124 - Creating and Maintaining Deposits

* AR225- Collecting Receivables

Interfaces

* INFARO13 - Customer Receipts Interface

* INFAROO06 - Inbound Interface AR items from external system

* INFAROQ7 - Outbound interface from AR (Summary and
Detail)
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Accounts Payable (AP)

Vendor Processor
AP Processor
Payment Processor

Payment & Voucher Approver

Inter Departmental
Invoices

Travel & Check
Expense Details

Supplier
Address

Create &
Process
Voucher

Asset Project related
Purchases Expenditures

v

Asset

Create
Supplier

Management

Project Costing

SCO payment

systems

Warrant
file

ePro/ Cash

Purchasing Management

Purchase Payment
Orders Payments Details

y

Process
1099
Withholding

Process
Payment

Expenditures
& Payables

\

1099
Withholding

General Ledger

§

&
=

Lo

EFT

e
'REPORTS

e AP Aging Report

¢ Open Prepayments

¢ Detail Payment
Report by Status
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» FisCal
Accounts Payable (AP)

Key Solution Characteristics: Configuration
» Paper Claims Replaced » CB_CAPO2 - Define SpeedChart codes for Chartfields
»  Eliminate String, 1” Stacks
» Statewide Vendor File
» Avoid duplicates
»  Access All Supplier Info
Online Approval Workflow Routing
» Email Notifications
»  Assign additional approvers
* 1 Invoice = 1 Voucher
»  Capture Multiple Fund and Appropriation per Invoice
»  Copy/Match Purchase Order
»  Attach Supporting Docs
» Department Check Printing
»  Standard FI$Cal Check Stock

Conversions

e« CNVAPO0O01 - Vendors

» CNVAPO0O04 - Unreconciled AP Payments (Outstanding
checks)

 CNVAPOO5 - 1099 Balances

Training Interfaces

* AP101 - Introduction to Accounts Payable * INFAPOO6 - Inbound Vouchers

e AP102 - Managing Vendor Information * INFAPOOS - Inbound CalATERS Interface

* AP113 - Voucher Processing * INFAPO12 - Inbound CalATERS Expenditure Interface
» AP114 - Office Revolving Fund Processing » INFAPO10 - Outbound CalATERS Check Detall

* AP123 - Voucher Workflow
» AP143 - Payment Processing
» AP153 - 1099 Withholding Preparation and Processing
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Cash Management (CM)

Accounts Accounts

Receivables Payables

CTS Bank Statements

Deposits Checks/

l Warrants
Cash Transfer Processor

Bank Statement Recon Bank
Bank Cash Cash

Processor Account S .
Cash Position Processor Management Reconciliation  Management ~ Forecasting 'RrEPORTS
CM Report Viewer demen

-

¢ Bank Statement
¢ Reconciliation
Exceptions Report
_ ¢ Outstanding
Accounting Transactions Report
Entries

|

General Ledger
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" Flscal
Cash Management (CM)

Key Solution Characteristics: Configuration
» Treasury Transaction Life Cycle: * None
» CTS banks statements reconciliation
* Includes the following types of Accounts:
» Centralized Treasury System accounts will be
maintained in FI$Cal system
» Warrant bank accounts

Conversions

* None
Training Interfaces
e CM101 - Introduction to Cash Management * INFCMO0O01 - Paid Items File From IPS
 CM112 - Reconciling Bank Statements * INFCMO002 - Bank Statement File From SCO

* CM122 - Managing and Maintaining Cash
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Departmental ePro/ Proiect Costi Accounts
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FISCal

Asset Management (AM)

Key Solution Characteristics:

»  Every department can track assets that assist with physical
inventory reconciliation

»  Better financial maintenance of assets

. Provides common asset repository across the State for
Asset Accounting and Tracking.

*  Automates financial accounting and depreciation
processing.

»  Streamlined asset creation and addition through integration
from Purchasing, Project Costing and Accounts Payable.

. Better management of Leased Capital and Land assets

Configuration

e CB_CAMO02 - Define Asset Classes,
» Asset Class
» Asset Attributes

conversions

¢ CNVAMOOL1 - Assets

Training

e AM101 - Introduction to Asset Management

 AM112 - Entering and Maintaining Assets

* AM122 - Adjusting, Transferring, and Retiring Assets

» AM132 - Processing Depreciation and Month-End Processing
* AM142 - Physical Inventory

Interfaces

¢ INFAMOO3 - Inbound interface to Add/Update Asset
Information (excel upload)

¢ INFAMOO4 - Outbound Interface to add/update transactions

¢ INFAMOOS - Outbound Interface for physical inventory

« INFAMOOG - Inbound Interface for physical inventory
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Labor Distribution (LD)

SCO Departmental
HR/Payroll Time Capture
System System
Payroll Employee Task Details
data data

v

Dept. LD Processor
Activity Sheet

Processor Load SCO Reconcile Process Resolve —
Dept. LD Maintainer Payroll Data Data LD Errors Re—

Employee IDs by Department Report
Missing Activity Sheet report

Payroll Table Error report

Chartfield Edit Error Report

Budget Check Report

Budget Exceptions page

-

Project Labor Labor_
Details Accounting

|

General Ledger

Project Costing
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» I FISCal
Labor Distribution (LD)

Key Solution Characteristics: Configuration
* Run Labor more than once a month « CB_CGLO3
» Fiscal Service Center reconciles payroll with SCO before » Define BU Options
Labor Distribution is run » Define Employee Group & Employee Options
* Provides ability to distribute costs using Default ChartField » Define Task Ids
combination and percentages (employee defaults., group » Define Benefit Type Options
defaults, task ids, etc.) » Serial Number Options, Class Types
» Provides ability to distribute costs via Activity sheets for » Payment Type/Payment type mapping

departments who do not have their own time tracking systems
» Provides ability to reclassify distributed payroll costs by
entering Adjustment Activity sheet

conversions

» Ability to allocate supplemental payroll by Payment types * None
» The solution generates Employee id that is a unique
identification used across several modules in PS
Training Interfaces
* GL202 - Introduction to Labor Distribution * INFGL105 - Inbound Employee interface
e GL253 - Understanding LD Configurations * INFGLO090 - Inbound Timesheet Excel Upload
* GL263 - LD Batch Processing and Error Reports * INFGLO091 - Inbound Timesheet Interface

October 2015 FI$Cal: Transparency. Accuracy. Integrity. 37



General Ledger (GL)

ournal Processor
ournal Approver
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" FISCal
Chart of Accounts (COA) :

Organization Codes [ . - | . _
Level 1 | AllOther || o Fund || Subfund | | Program || Element || Component | Tas Project
Business Reporting
Unlt Structure Fund Program Proj ract

Legacy

Agency Use Statistics Code Budget Period
Alternate Appropriation Enactment
AEEDUI‘It Account Reference Year
34 4

[Dbject [ Receipt ][ GL J [Agency [Agenqr] [ Appropriation ] Year of

FISCAL

Code Code Code Source Object Reference Enactment

Legacy
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" S FisCal
General Ledger (GL)

Key Solution Characteristics: Configurations
» Statewide Book of Record under multiple bases of accounting e CB_CGLO6
(Cash, Modified Accrual, Full Accrual, Budgetary/Legal) » Define department ChartFields
« Statewide Chart of Accounts supplemented by departmentally » Define alternate accounts ChartFields
defined codes (Alternate Account, Reporting Structure, » Define operating unit ChartFields
Service Location) » View and modify tree
» Automated cost allocations » Create predefined ChartFields combinations
» Automated investment accounting » Legacy UCM to FI$Cal COA Translation
» Automated recording of Transaction Requests for Non-FI$Cal
departments

Conversions
 CNVGLOO0S8 - Ledger balances

Training Interfaces
e GL101 - Introduction to General Ledger * None

* GL112 - Processing Journal Entries

* GL132 - Process Allocations

e GL142 - Working with Chart of Accounts

* (GL243 - Closing Monthly Accounting Periods
* Month-End Close

* Year-End Close
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Commitment Control (KK)

Accounts
Payables

General
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Project Costing
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l I

ORACLE Labor
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Purchasing
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Commitment Control (KK)

Key Solution Characteristics: Configuration
» Transactions are controlled at appropriation level »  Define Departmental Operating budgets
» Departments can breakdown appropriation operating budget

amount

» Track Expenditure and encumbrances against budget amount
* Real time budget actuals reporting capability

Conversions
e CNVGLO009 - Commitment Control

Training Interfaces
e GL122 - Commitment Control Transactions « None
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2016 Release Key Departmental Activities

Department Mobilization . : . Interfaces and
. Business Processes Configuration :
and Readiness Conversions

Enables departments with people, Provides departments with Allows departments to define Interfaces: Allow departments to
tools, and other resources to information about FI$Cal business values for specific items in FI$Cal electronically send data from
prepare their department for processes, along with tools and (e.g., list of ship-to locations). departmental systems that will not
FI$Cal and to ensure a successful FI$Cal Project Team support to Most configuration values apply to be retired into FI$Cal.
transition. This includes setting up identify change impacts and Chart of Accounts and Labor Conversions: Allows departments
a Department Implementation update internal department Distribution. to extract, cleanse and validate
Team (DIT) to coordinate the business processes. data from legacy systems that will
completion of all tasks and be retired to enter into FI$Cal.
activities.

Role Mapping Departmental Testing Training Deployment
Allows departments to assign Provides departments with the Provides department end users Prepares departments to fully
security roles to all department opportunity to complete common with the knowledge and skill to transition to using FI$Cal as part
end users based on their job transactions in FI$Cal in order to perform transactions in FI$Cal. of their day-to-day business. This
requirements and the type of work validate that the system performs Training courses are offered via includes practicing activities the
they will perform in FI$Cal. as planned. web-based and instructor-led way they will happen right before
Security roles define what users options. the system goes live.

can see and do in FI$Cal.
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Overall Timeline of Key Departmental
Activities

el

Solution
) WELS
Business Throughs

Processes B 3 Business
As-Is Dept. Business Process To-Be Department Business Processes
Processes
Workshops
Configuration
Worksh
Configuration
Configuration
Design

End-User

Workstation
Requirements

0
Workshops
Conversions
Conversions
ROI? Role Mapping for
Mapping
) Workshob Core-Users
Role Mapping
Role Mapping
for Testing

Departmental UAT Scenario . .
. } Testing Sessions
Testing Review
Training Needs Training Needs Core Training S_Ig;:;:idnary ILT Stjsegrt
GWEWSIS Analysis Update Registration Reqistr t'g n s ngs
Training 1slralo
Training Delivery

Depl t ress Cut-
eploymen ehearsal | over
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The Transition to FI$Cal

m  Change Management — Structured, result-driven and holistic approach to
change in organizations, teams, and individuals that:

Enables the successful transition from the current to the aspired future
state

Ensures the realization of the planned business objectives

m In essence, Change Management is about winning people’s heads and
hearts to drive the business case of a transformation.
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Stages of Change

Plan & Analyze Design Build & Test Deploy and Transition
* |Inform stakeholders * Inform stakeholders how * Inform stakeholders about | | * Inform stakeholders of
» Communicate project they will worcwith the new the upcoming key project milestones
timeline, intended changes implementation * Communicate issues
audience, andsystemto * Communicate system and | |+ Communicate all rollout and resolutions
beimplemented business process changes activities v Inform stakeholders of
* Inform stakeholdersabout | * Inform stakeholders of v Inform stakeholders of ongoing sup part
wherethey can obtain trainingto be provided trainingtimeline and pProcesses
program information enrollment process

Change Commitment Curve

Commitment

* Explainthe benefits
* Usethe new system to do

Acceptance

* Explainchanges to the

PEXplaintheimpactto their | | , DUSINess processes

role * Explain how it will be their job

| ImEENIESSE * Participation in support
Understandthe needfor » Explain how theywill use it E.C‘ti‘iitigs-ﬂ.ndfﬂllngfpup
T to dotheir jobs

v Explainthe goals, purpose, | * Usechange network to
and rationaleforthe project | communicate key change
* Explainthe benefits MEASUres
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Pace of Change

¥ wgﬁo“ o0
Commitment C O “90( 0 93(‘ “&a“ a‘““s
- Articulates the change as norms 590 G(s“ 0e \G((\‘a 009\)56‘
- Articulates his/her personal ead “(\9 ,‘Ga‘“ e“d
ownership of the change v

Acceptance ¢ D
- Works toward change

- Invests time in change
- Articulates commitment
to goals of change

Understanding ¢ »
- Accepts nature and
intent of change

Support for Change

Awareness ¢ O
- Encounters change

- Realizes change
IS imminen
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Change Network Structure to Support End
Users

L o
=
= g Customer Impact || FI$Cal Steering FI$Cal Partner FI$Cal Project
c 3z Committee Committee Agencies Leadership
3 @
O -l
=8 FI$Cal Change Management Office
25 Department
& : -~ epartmen .
= nsorshi :
LA ( Sponsorship EZCommunlcatlonszz Readiness ZZ Training >
Department Liaison
= Department Sponsors Network (DLN)
GE) | Department Implementation Team (DIT) | /,/
= + Department Project ~ « Business Liaison ,/’/ ______ DIT Workgroups
g_ Manager * Technical Liaison ;:—':: ——————————
@ » Department Liaison * Training Liaison " TTTe-ol
a « Change Champion ~ TTTte.__ |
T Super Users
()
Q
c
% FI$Cal End User
S
<
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Super Users

m  Super Users have been identified by every department to assist in the
FI$Cal implementation process

m A Super User :
has deep knowledge of a department's business processes

Is empowered to make departmental decisions (pulling in additional
resources when needed)

can commit for the implementation period through July 2016

m Via training, learning the FI$Cal business processes, and collaborating with
the Department Implementation Team (DIT) and FI$Cal Project, Super
Users will become the most FI$Cal-savvy department staff and become the
department’s key support after go live
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Department Implementation Team Structure

el

Department
Project
Manager

Department

Readiness giatats Department

Liaison

Business
Liaison

Technical
Liaison

Change Training
Champion Liaison

Super Users

——————————

SMEs SMEs
as needed as needed

SMEs
as needed

SMEs
as needed
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Agenda

Department Readiness Tools
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Touchpoint Meetings

m Description

Recurring meetings to review the Master Department Workplan,
support department readiness activities, and address department
guestions and concerns on the FI$Cal Project

m Participation
FI$Cal Department Readiness Coordinator
Department Liaison
Department Implementation Team members, as needed
Department Sponsors, as needed
Department Subject Matter Experts, as needed
m Frequency
Biweekly (web conference, conference call, in-person meeting, or email)
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Master Department Workplan

Figgal

Activity /  Activity / Task Name Activity / Task Description Activity / Task  Activity / Task Activity / Task Activity / Task Resources or
Task ID DIT Owner(s) Start Date End Date Supporting Documents
READO002 | Identify Department Review the Department Implementation Team (DIT) Department 09/11/12 09/21/12 Task instructions and response
Implementation Team (DIT) roles and responsibilities provided in the task Liaison template
documentation. Assign one individual and optionally
one back-up for each role.
TRNGO01 | Respond to Training Needs Respond to Training Needs Analysis survey from Training Liaison 09/26/12 10/10/12 Link to survey
Analysis FI$Cal CMO Training.
SPONO0O01 | Participate in Sponsor Interviews Department Sponsor and as appropriate, Leadership | Department @‘ 10/26/12 Notes will be provided to the
Team, meet with the FI$Cal CMO to discuss Pre- > Department Sponsor following the
Wave activities and expectations. meeting
BUSNOO1 | Gather "As-Is" Process Business Liaison gathers their "As-Is!" 11/05/12 12/28/12 Task instructions
Documentation
COMMO04 | Share January DLN Meeting Department 01/10/13 01/17/13 Presentation to be posted to FI$Cal
Materials Liaison and Project website, www.fiscal.ca.gov.
hange Champion, to Change
Project messages throughout Management
their department. Champion
TECHO003 | End User Workstation Technical Liaison validates FI$Cal end user Technical 02/04/13 05/31/13 Task instructions and response
Hardware/Software Requirements | workstations at the department meet the FI$Cal Liaison template

Project-determined requirements for hardware and
software.

October 2015
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Department Readiness Dashboard

m
FISCal
“\\_\zz

m The dashboard is prepared monthly by the FI$Cal Project based on a
department’s scorecard

m A department’s scorecard lists all outstanding task; outstanding tasks are
identified as “red” in the dashboard

m Dashboards are shared with the Steering committee and used for
communicating at the Leadership/Sponsors level within the department

Sample Readiness Dashboard

-
W

anagement

Missing configuration values for Purchasing and Asset

Readiness Category [iGEL I ESSAE QS Status
SPON Participate in Sponsor Briefing
COMM Share FISCal meeting materials
READ Attend Department Liaison Network meeting
Complete training deployment plan
TRNG . -
Register end users for training
Submit confi jion value
BUSN Update
TECH

conversion and interface files

Delay in data cleansing activities may delay readiness of

October 2015
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Upcoming Activities
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READGO3 — Provide 2016 Release |
Department Contacts

m Objective — Assign one department individual to each Department
Implementation Team (DIT) role, and identify individuals to participate in the
first User Readiness Survey

m Duration — 2 Weeks

m Department Participants — Department Liaison

m Key Activities
Review the DIT roles and responsibilities
|dentify participants for the first User Readiness Survey
Populate READ603 Response Template
Submit Response Template (11/13)
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READGO3 — Response Template

Department DIT Role Last Name  First Name Email

Department Sponsor

Department Project Manager e
Department Liaison
Change Champion
Training Liaison
Business Liaison !
Technical Liaison

Department Name Last Name First Name Job Classification
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TRNG601a — Respond to Training Needs
Analysis

m Objective — Identify training and support needs for departmental end users

m Duration — 5 Weeks

m Department Participants — Training Liaison

m Key Activities
|dentify training and support needs
Respond to Training Needs Analysis survey (12/18)
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COMMG602 — Develop Department
Communication Plan

m Objective — Create a plan for sharing information both internally an
externally to your department

m Duration — 3 Weeks

m Department Participants — Change Champion

m Key Activities
Asses communication needs at department
Populate COMMG602 Response Template
Submit Response Template (12/04)
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COMMG602 — Response Template

FisCal

Audiencef
Stakeholder

Key Message Desired Outcome

Content Owner |Sender

07/14/14 |07/18/14 |Workshop |Department End-|Overview on Canference Room |To educatean BPR, CRP, and | Ricks - SME Change FisCal Website
Users Pilots {CRPs) and Wave 1 BP8es To cascade N Penska - SME |Champion
Solution Walkthroughs (SWTs 1“ gh Department |Department
Ligison
2| 03/01/14 | 03/05/14 |Activity Department To| o engage Department SME in  |T Goh; Department |Department
Subject Matter the design activity of BPW H Heller; Ligison email
Experts M Biel
3
4
5
FI$Cal: Transparency. Accuracy. Integrity. 64
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TECHG601 — Review the Data Classification
and Protection Framework

m Objective — Review the Data Classification and Protection Framework and
identify additional data classification and protection requests

m Duration — 1 Week

m Department Participants — Technical Liaison

m Key Activities
Review the Data Classification and Protection Framework
|dentify additional data classification and protection requests
Populate TECH601 Response Template
Submit Response Template (11/20)
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TECHG601 — Response Template

Data Classification and Protection Response Template
Process Name Desired Field Protection Requests Add Comments
Description (see color boxes
above)

53 Data Classification and Protection Framework Completion

= Align with FI$Cal's Standard Protection Framework

* Department Name:

« Data Owner Name:

« Date Data Classification and Protection
* Framework Complete:

October 2015 FI$Cal: Transparency. Accuracy. Integrity. 66



" S FisCal

TECHG602 — Submit Conversion Inventory

m  Objective — Identify department participation in conversion activities

m Duration — 3 Weeks

m Department Participants — Technical Liaison and Business Liaison

m Key Activities
Review proposed conversions with FI$Cal
|dentify conversions in which department will participate
Populate TECH602 Response Template
Submit Response Template (12/18)
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TECHG602 — Response Template

Module K M Conversion Scope M Farticipation Kl CALSTARS Rl Impacted Systems v

AM Assets All assets for State of California which are in-service (not retired). Capital
(over $5K) and Non-Capital {under 55K) assets will be converted into FISCal
including all tangible and Intangible assets used in State Government's
operations.

AP Vendors All vendors the department is actively doing business with and cl.lrrentI‘,.r used
on Procurement and Accounting Transactions. This includes Claim
Remittance Advice and Reportable Payment. Vendorsdoclud

Government Agencies. If not using CALATERS, vel ill

Employee Information.

The vendor list should only include vendors used in Fiscal Year 2014-2015
and if known, those planned for use in Fiscal Year 2015-2016.

AD llmrarancilad AD Danrmmante FICrzsl will marmvart llInrarAamcilad Acecmnmde Davzhla Araner Dovrmant Asts fram
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BUSNG603 — Order and Test New FI$Cal
Check Stock

m  Objective — Order FI$Cal check stock and test the FI$Cal check stock
printing process in preparation for go live.

m Duration — 4.5 Months

m Department Participants — Department Liaison and Business Liaison

m Key Activities
BUSNG603a — Order New FI$Cal Check Stock (1/29)
BUSNG603b — Test FI$Cal Check Stock Printer (3/04)
BUSNG603c — Test New FI$Cal Check Stock (4/01)
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Next Steps

m  November
Participate in Sponsor Interviews
Review and Understand Department Readiness Scorecard
Participate in Solution Walkthroughs (SWTSs)
Respond to User Readiness Survey

m December
Participate in Model Office
Validate End User Workstation Hardware/Software Requirements
Participate in Department Roadshow
Attend Sponsor Briefings
Gather As-Is Business Process Documentation
Establish Departmental Authority and Designee (DAD)
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Questions

FI$Cal Project Information:
http://www.fiscal.ca.qgov/

or e-mail the FI$Cal Project

Team at:
fiscal.cmo@fiscal.ca.gov
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CMO Team Leadership

m CMO Leadership and Sponsorship
Kelly Holtz, CMO Deputy Director
Juan-Carlos Palacios, Department Support Lead
Danese Hammond, CMO Assistant Deputy Director
Yesenia Reyes, Accenture Change Management Lead

m Department Readiness Team Leadership
Goldie Parino, Department Readiness Manager
Kira Connell, Accenture Department Readiness Lead

m  Michael Muth, Communications Manager
m Training Team Leadership

Anthony Ampania, Training Manager
Stephen Britcher, Accenture Training Lead
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Change Network

m  The Change Network is designed to support departments and their end
users in preparing for FI$Cal

m  Through the Change Network, departments will take responsibility for
preparing their organization and end users

m  The Change Network is the network of groups and individuals designed to

support the change effort to implement FI$Cal and ready the departments
and their end users

m  The Change Network is three groups, each of which help support the

change effort to implement FI$Cal and ready the departments and their end
users:

Governance/Leadership
FI$Cal Project
Department
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DIT — Department Implementation Team

m  The Department Implementation Team (DIT) provides direct support to the
department in the implementation of FI$Cal

m Individuals on the DIT fulfill several key roles, which relate to the FI$Cal
Project Teams

m The DIT is led by the Department Liaison and supported by:
Change Champion
Training Liaison
Business Liaison
Technical Liaison

m Departments may also want to assign a Department Project Manager to
assist with coordinating FI$Cal activities
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DIT — Leadership Support

m  Governance/Leadership
Guides the implementation of the FI$Cal Project
Addresses FI$Cal Project issues and risks
Makes project decisions

Serves as a role model to the departments and FI$Cal end users by
supporting the change

m FI$Cal Project Team

Provide leadership and direction to the departments from the change,
business, and technical perspectives

m Business Team
m Technical Team
s Change Management Office
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DIT — Project Team Support

m Business Team

Designs the new FI$Cal business processes with Partner Agencies and
representative departments

Assists CMO in communicating new processes to the departments

m Technical Team

Assists CMO in guiding departments to prepare their interfaces, lead
conversion activities, and set up of User IDs associated with FI$Cal
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DIT — Project Team Support

m  Change Management Office (CMO)

Prepares for, manages, and reinforces change-related activities

m Responsible for planning and guiding Partner Agencies,
departments, and end users in their transition to FI$Cal

m Continued guidance throughout the implementation phase
Timely communication regarding project status and activities
Strategic education and training to facilitate change

m Areas of the CMO
Sponsorship
Communications
Department Readiness
Training
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DIT — Department Sponsors ==

Role Description:

Champion the FI$Cal Project vision and goals within their department
Prepare, monitor, and ensure department readiness for change

Identify and communicate department needs, impacts, and concerns to the
FI$Cal Project Teams

Act on FI$Cal Project requests and/or requirements

Communicate FI$Cal Project status and departmental impacts to
department Executives and Managers/Supervisors

Ensure FI$Cal Project communications are cascading through the
organization

Provide and support department resources involved with FI$Cal
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Dapamant
e
snagi

DIT — Department Project Manager Mj“‘;:'f‘f;'_

Role Description:
m Manage the department’s implementation activities for FI$Cal

Create Project Schedule based on Master Department Workplan
(MDW)

Coordinate with the DIT, especially the Department Liaison

Track department status of FI$Cal assigned and internally identified
tasks and activities

Report status to Department Sponsor and Leadership Team
m Provide support to Department Sponsor and Leadership Team

Coordinate communication activities

Manage risks, issues, and opportunities for improvement
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DIT — Department Liaison e

Role Description:

m Coordinate and lead the DIT
Support and suggest activities for the Sponsor
Work closely with the other DIT members

m Attend FI$Cal DLN meetings and act as focal point of communication and
interaction between the FI$Cal Project and the department staff

m  Manage Project Master Department Workplan and status
Explain activities and tasks to the DIT and track their completion

Report status to Department Sponsor and Leadership Team and FI$Cal
Department Readiness Coordinator

|dentify, add, and manage department-specific tasks for internal
departmental readiness
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DIT — FI$Cal Department =
Readiness Coordinator o e e e =
Role Description:

m FI$Cal Department Readiness Coordinator:

Acts as primary point of contact between department and the FI$Cal
Project Team

Coordinates activities and communications with Department Liaison
Assists the department in expressing their needs to the Project Team
Provides insight and support to the department on tasks and activities
m Managing Master Department Workplan
m Preparing the Department Readiness Scorecard
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DIT — Change Champion B

Role Description:

m  Communicate with department stakeholders early and often to accelerate
buy-in to the FI$Cal Project to reduce barriers and constraints

m Involve Sponsors, Managers, Supervisors, Subject Matter experts to speak
to the change involved with FI$Cal

m Identify activities and messages that help staff achieve change readiness

m Educate people involved about change management and what they can
expect from the changes that will be put into place

m Inspire active participation in major milestone activities to create ownership
into the process and changes ahead

m |dentify and manage resistance
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DIT — Change Champion -

Example Tasks:
m  Communicate FI$Cal Project messages throughout the department

m  Support the Department Sponsor, managers, and supervisors in
communicating timely, consistent messages to department end users

m  Work with other DIT members to lead conversations about needed change
and impacts to the department

m  Work closely with the Business Liaison to educate users on the business
process changes and encourage adoption of the changes
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DIT — Training Liaison _—=

Role Description:
m Support and implement the FI$Cal Project’s training program

m Participate in Training Needs Analysis and department interviews to support
training delivery

m Provide administrative and logistical support for training activities
m  Communicate to FI$Cal Project the department’s training needs
m Perform training support logistics

|ldentify and reserve training facilities

|dentify and register trainees

Support tracking of training completion
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DIT — Technical Liaison —
=

Role Description:

m Coordinate the department’s technical site preparation for implementation,
for example:

System validation

Interface development

Data conversion

Security set up and activities

Departmental connectivity and desktop set up for the FI$Cal system

Infrastructure for interface transmission
m Coordinate and participate in interface, conversion, or other testing activities
m Manage the process to assign FI$Cal roles to end users
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DIT — Business Liaison =

Role Description:

Lead and support analysis of business process changes as a result of to-be
processes on department roles, processes, and policies

Lead and coordinate the identification of and update of departmental
procedures

Coordinate the department’s participation in the Business Process
Workshops (BPW) to review the new FI$Cal business processes

Provide input or other support for testing the FI$Cal system
Support training on new business processes

Support the process of assigning FI$Cal end user roles and establishing
workflow

Submit identification of department values necessary for configuring
department-specific information into the FI$Cal system
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MDW — Activity / Task ID Column

FiSCal

Task ID

Prefix

Task Area

Related Key Activities

READ601 | READ | Department Readiness | Department Mobilization and
Readiness

TRNG601 | TRNG | Training Training

SPON601 | SPON | Sponsorship Department Mobilization and
Readiness

BUSN601 |BUSN | Business Configuration, Business
Processes, Deployment

COMM601 | COMM | Communications Business Processes, Deployment

TECH601 | TECH | Technical Interfaces and Conversions, Role
Mapping, User Acceptance
Testing, Deployment
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MDW — Activity / Task Name and
Description

Activity / Task Name Activity / Task Description Nam e — Short descriptive
)

Identify Department Implementation | Review the Department Implementation Team (DIT) name for the Work |tem

Team (DIT) roles and responsibilities provided in the task

documentation. Assign one individual and optionally one
back-up for each role.

Analysis survey from Fi$Cal | l DeSCFiption - Bl‘ief
_ explanation (3-5
o Praove sentences) of the activity

Respond to Training Needs Analysis | Respond to Training Ne
CMO Training.

Participate in Sponsor Interviews Department Spaons

or task to help understand
Gather "As-Is" P Ui : hers their "As-Is" process what the department will
Documentati ) -Wave functionality of requisitions
ant purchase orders to prepare for Business Process need to do.
Workshops.
Supplemented by the task
Share January Following the DLN Meeting, the Department Liaison . . h
Materials should work with the Department Implementation Team, |nStrUCt|OnS or Ot er
especially the Change Champion, to communicate ; ;
FI$Cal Project messages throughout their department. Supportlng documentat|0n
End User Workstation Technical Liaison validates FI$Cal end user
Hardware/Software Requirements workstations at the department meet the FI$Cal Project-

determined requirements for hardware and software.
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MDW — Activity / Task Name and
Description

Activity / Task Name Activity / Task Description Nam e — Short descriptive
)

Identify Department Implementation | Review the Department Implementation Team (DIT) name for the Work |tem

Team (DIT) roles and responsibilities provided in the task

documentation. Assign one individual and optionally one
back-up for each role.

Analysis survey from Fi$Cal | l DeSCFiption - Bl‘ief
_ explanation (3-5
o Praove sentences) of the activity

Respond to Training Needs Analysis | Respond to Training Ne
CMO Training.

Participate in Sponsor Interviews Department Spaons

or task to help understand
Gather "As-Is" P Ui : hers their "As-Is" process what the department will
Documentati ) -Wave functionality of requisitions
ant purchase orders to prepare for Business Process need to do.
Workshops.
Supplemented by the task
Share January Following the DLN Meeting, the Department Liaison . . h
Materials should work with the Department Implementation Team, |nStrUCt|OnS or Ot er
especially the Change Champion, to communicate ; ;
FI$Cal Project messages throughout their department. Supportlng documentat|0n
End User Workstation Technical Liaison validates FI$Cal end user
Hardware/Software Requirements workstations at the department meet the FI$Cal Project-

determined requirements for hardware and software.
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MDW — Activity / Task Owner(s), Start Date,
and End Date

Activity / Task DIT  Activity / Task  Activity / Task

m DIT Owner(s) — Provides the DIT
Depatment 00/11/12 00/21/12 membgr.responsmle for taking action on
Liaison the activity or task, such as completing a
Training Liaison 09/26/12 10710112 spreadsheet or coordinating the sharing
Department 10/01/12 1012682 of information within their department

Liaison and
Department
Sponsor

Owner(s) Start Date End Date

m Start Date — Date the activity or task is

12/28/12

planned to start
01/10/13 01/17/13

Lial
Change . .
Management m End Date — Date the activity or task is
Champion

planned to end or be completed by
Technical Liaison 02/04/13 05/31/13
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MDW — Activity / Task Owner(s), Start Date,
and End Date

Activity / Task Resources or .- ‘- . ;
m ldentifies when.a.ddltlonal materials are provided to
Task instructions and response Support the aCtIVIty or taSk

template

Link to survey

_ : m  Examples include an instructions document, task
Notes will be provided to .
Department Spo \3 completion template, or reference to the FI$Cal
the meetin . .

Project website

Presentation to be posted to
FI$Cal Project website,
www.fiscal.ca.gov.

Task instructions and response
template
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